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IBM Order Capture Business Component Version 1.1 
Installation Guide 
The IBM Order Capture Business Component is deployed as a WSBC Advanced Component (AC). This document 
describes the installation, the setup required to use the Order Capture AC, and the setup required to use the Order 
Capture sample.  

The green text represents changes that were made to this document after the Order Capture Business Component 
Version 1.1 CD was created. 

Installation prerequisites 
The following are the prerequisites for installing Order Capture files. 

Software 
The Order Capture installation has an dependency on IBM WebSphere Business Components Studio, Version 1.1. 
You must install WSBC Studio before installing any Order Capture files on your workstation. It is recommended 
that you install the WebSphere® Application Server before installing WSBC Studio. 

Hardware 
The Order Capture AC installation procedure does not have any additional hardware prerequisites for installation 
other than those required by WSBC Studio. 

Install the product from the CD 
To begin installation, perform the following steps:  

1. Insert the CD in your CD-ROM drive. 

2. Use Microsoft® Windows Explorer to navigate to the CD's directory. Select the OCInstall directory, and 
run the Setup.exe file. 

3. You have a choice between a Typical or Custom installation. It is recommended that you choose the 
Typical installation, which installs the Order Capture AC files, documentation, and sample.  
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Order Capture Advanced Component 
This information is provided as a reference for those customers who will be using the Order Capture AC in their 
application. It includes the .jar files, classpaths, and DB2® setup that are required.  

To install and run the Online Sales Desk Sample (which uses Order Capture), you do not need to perform any of 
these steps. Go directly to the Online Sales Desk Sample section.  

.jar files 
The following are the Java™ packages for the WSBC Order Capture AC:  

• ACOrderCaptureEJBDeployed.jar Contains the standard EJB Deployed .jar file 

• ACOrderCaptureEJBClient.jar Contains the standard EJB Client .jar file 

• ACOrderCaptureEJB.jar Contains the standard EJB .jar file 

• ACOrderCaptureCommon.jar Contains the definitions for the argument classes and must be in the 
classpath for the client (if using the object-oriented Order Capture interfaces), the WebSphere Application 
Server, and the SanFrancisco™ servers 

• ACOrderCaptureServer.jar Contains the internal implementation of the Order Capture AC and 
must be in the classpath for the WebSphere EJB server and the SanFrancisco servers 

• ACOrderCaptureServerSF.jar Contains the internal implementation of the Order Capture AC and 
must be in the classpath for the SanFrancisco servers 

Configure the classpaths 
There are several paths that you must add before your application can be deployed and run. Each of these is 
described below. 
Ensure that there are no spaces in your PATH or CLASSPATH environment variables. If there are spaces, specify 
the directory as XXXXXX~1 where XXXXXX is the first 6 characters (not spaces) of the directory name. If the 
directory is over 6 characters, add "~1" to the end. 

System classpath 
Add the WSBC_ROOT into your system classpath; for example, C:\PROGRA~1\IBM\WSBC\1.1\

System path 
Ensure that the following path is in your system PATH environment variable: <WSBC directory>
\com\ibm\sf\bin 

Dependent classpath 
The dependent classpath is a text box that you can view by clicking on the node in the WebSphere Administrator's 
Console. This classpath is only used to deploy an Enterprise JavaBean™ (EJB) and the classpath may be deleted 
after the EJB's deployment. Placing a value in the text box is equivalent to adding the value in the admin.config 
file. When deploying the Order Capture AC, set the dependent classpath as follows (without any line breaks): 
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACEI18NEJBClient.jar;
C:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\
ACOrderCaptureEJBClient.jar;



 

 Copyright IBM Corp. 2000 3 

C:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\ACOrderCaptureEJB.jar;
C:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\ACOrderCaptureCommon.jar;
C:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\
ACOrderCaptureServerSF.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\jmxri.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesServer.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesSMClient.jar;

Server classpath 
The server classpath is in the server's command line arguments text box. The value of the classpath is used by the 
running EJB. For any class that is not found, an exception will show up in the logs disguised as a remote 
exception.SF, which is needed for SFException. Set the server classpath to the following value (without any line 
breaks): 
-classpath
C:\PROGRA~1\IBM\WSBC\1.1\;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACEI18NEJBClient.jar;
C:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\
ACOrderCaptureEJBClient.jar;
C:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\ACOrderCaptureEJB.jar;
C:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\ACOrderCaptureServer.jar;
C:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\ACOrderCaptureCommon.jar;
C:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\
ACOrderCaptureServerSF.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\jmxri.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesServer.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesSMClient.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesEJBClient.jar;

Web application classpath 
This classpath is set on the Web application under the WSBC servlet engine. It is used by the servlet that the client 
application starts, and requires several Open Applications Group Interface Specification (OAGIS) .jar files, and 
SanFrancisco. The value of the Web application classpath is as follows: 
$WSBC_ROOT$Services\BaseServices\ACEI18NEJBClient.jar
$WSBC_ROOT$Services\BaseServices\jmxri.jar
$WSBC_ROOT$ACFeatures\Components\OrderCapture\ACOrderCaptureCommon.jar

Command line classpath 
The command line classpath is used to prime the SanFrancisco part of Order Capture, start and stop the System 
Management Beans, start and stop the components, and run the data setup. The value for the command line classpath 
can be set by running the following command prior to any run (without any line breaks): 
set classpath=%CLASSPATH%;
C:\WebSphere\AppServer\lib\ujc.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesEJBClient.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesClient.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesServer.jar;
C:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\jmxri.jar;
C:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\ACOrderCaptureServerSF.jar

Modify the admin.config file 
Modify the admin.config file as follows: 
1. Close the WebSphere Administrator's Console.  
2. Shut down the IBM WS AdminServer Service.  
3. Open the C:\WebSphere\AppServer\bin\admin.config file in a text editor such as  Notepad. Find the line in this 

file that starts with the following string:  
com.ibm.ejs.sm.adminserver.classpath  
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Assuming that <WSBC directory> is C:\WSBC, append to this line the following string (without the line 
breaks): 
;C\:/WSBC;
C\:/WSBC\ACFeatures\Components\OrderCapture\ACOrderCaptureServerSF.jar;
C\:/WSBC\ACFeatures\Components\OrderCapture\ACOrderCaptureCommon.jar;
C\:/WSBC\ACFeatures\Samples\OrderCapture\OCS.jar;
C\:/WSBC\Services\BaseServices\ACServicesEJBClient.jar;
C\:/WSBC\Services\BaseServices\ACServicesClient.jar;
C\:/WSBC\Services\BaseServices\ACServicesServer.jar;
C\:/WSBC\Services\BaseServices\jmxri.jar
Note: In the admin.config file, you must precede the colon (:) character with the backslash (\) character. 

4. Save the admin.config file. 

Deploy the Order Capture AC 
The Order Capture AC has the following Beans:  

• OrderCapture 

• OrderCaptureFulfillment 

• OrderCaptureMaintenance 

In addition to these Beans, the Order Capture AC requires that the following AC Services Beans also be deployed in 
WebSphere:  

• LocalizableTextResourceAccessor 

• ACCommandTarget 

• MBeanServerConnector 

To deploy the AC Services Beans, see "Deploy AC Services EJBs in WebSphere Application Server" in the IBM 
WebSphere Business Components Studio Version 1.1 Installation Guide, in the  "Advanced Component Services" 
section, under "Deploy the AC Services in WebSphere Application Server." You can then use the same instructions 
to deploy the three Order Capture Beans, using the ACOrderCaptureEJBDeployed.jar file. Deploy these three Beans 
in the same WebSphere server (the default is WSBC Server) where the AC Services Beans were deployed. 

Note: If you choose not to use the default install path during the installation, you must make a manual change to the 
DTDPath. After Order Capture is deployed, the System Management Console can be used to change the value of the 
DTDPath to point to the appropriate directory in the installation path that contains the DTDs. Refer to "Add .jar files 
for the AC System Management Console's classpath" and "Configure the System Management Console" in the IBM 
WebSphere Business Components Studio Version 1.1 Installation Guide for further information. 

Run the AC Deployment Tool 
The AC Deployment Tool can be used for the Order Capture AC. This tool will register the necessary names in 
JNDI so that the Order Capture AC functions can be accessed. (The AC Deployment Tool does not actually deploy 
any EJB's.) The tool uses the default deployment descriptor file provided with the Order Capture AC.  

The Online Sales Desk sample application deploys the Order Capture AC using a Java program and does not use the 
default deployment descriptor provided. For more information on how the sample deploys the Order Capture AC, 
look at the sample source code. The sample uses slightly different names in JNDI so they will not conflict with the 
default names supplied in the Order Capture deployment descriptor.  

When you run the AC Deployment Tool you will need to verify or change some of the default values. 
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To run the tool:  

1. Start the AC Deployment Tool and load the ACOrderCaptureServer.jar file. 

2. On the General tab, verify the Instance Name field. This will be the name used to reference the AC. If this 
is changed, the modelMBeanDescriptor name in the Order Capture ACImplementation.xml in the 
ACOrderCaptureServer.jar file will have to be changed. 

3. On the General tab, verify the Global Context URL and Global Context Factory values are correct. You 
will not normally have to change these fields. 

4. Select each function group. In the Function Group pane, verify the Function Group Registered Name 
field. This field must match the JNDI home name for the deployed EJB Session Bean. There are three EJBs 
for Order Capture: OrderCaptureMaintenance, OrderCaptureFulfillment, and OrderCapture. Verify that all 
three of these match their JNDI home names. 

5. For each function name in each function group, verify the Target Registered Name. Click on the function 
name and in the AC Function pane check the Target Registered Name. This name must match the JNDI 
home name for the ACCommandTarget deployed EJB. Check each function. 

6. From the menu bar select Action > Set Preferences. In the URL field change the 
value to IIOP://localhost:900/. Click OK. 

7. Verify the AC by selecting the instance node and selecting Actions > Verify AC instance from the menu 
bar. 

8. Once the verification is successful, deploy the AC by selecting the AC instance node and selecting Actions 
> Deploy AC Instance from the menu bar. 

OrderCapture.ini file 
You can add an .ini file to the C:\PROGRA~1\IBM\WSBC\1.1\com\ibm\wsbc\ac\OrderCapture directory. The name 
of the .ini file should be the same as the company name attribute set on the Order Capture AC. (For example, if your 
company name attribute is OrderCaptureCompany, then the .ini file name should be OrderCaptureCompany.ini.) 
The company name attribute can be viewed or changed using the System Management Console. 

The .ini file contains a list of .xml files that are to be processed as part of the initial OrderCapture AC setup. Using 
the System Management Console, you can run the CreateData() method on the OrderCapture AC. When this method 
is run the first time, the Order Capture AC will look for the .ini file and will process each .xml file listed in order. 
This is a one-time initialization. The format of the lines in the .ini file are: 
c:\\xml\\OC_setup_1.xml
c:\\xml\\OC_setup_2.xml

The full path and file name is required for each .xml file name. 

Setup for DB2 
The Order Capture DB2 setup (either initiated at the end of the installation of Order Capture or by running the 
OCConfigDB2.bat file) can perform the following if DB2 is installed and if you are authorized to create tables in 
DB2. If this was not completed after installation, follow the steps below.  

Create the database 
Create the database using the following SQL command shipped for DB2:  
db2cmd db2 -f $WSBC_ROOT$\com\ibm\sf\db\db2\OCAC-Create-DB2-Database.sql
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Create the tables 
Connect to the database and use the following command to create the tables in the database:  
db2cmd db2 -f $WSBC_ROOT$\com\ibm\sf\db\db2\OCAC-Create-DB2-Table.sql

Create the indices 
Connect to the database and create indices for some of the tables by using the following command:  
db2cmd db2 -f $WSBC_ROOT$\com\ibm\sf\db\db2\OCAC-Create-DB2-Index.sql

Setup 
Prime SanFrancisco for DB2 by using the following command:  
java com.ibm.sf.gf.NamingAdmin -reset -containerprimelist OCAC-Prime-DB2.list

Setup for Oracle® 
If you are using Oracle, you must modify the SFConfig.ini file that is located in your WSBC install directory 
(for example, C:\PROGRA~1\IBM\WSBC\1.1\SfConfig.ini). 

1. Find the following line in the SFConfig.ini file: 
datastore=//db2/OCAC:NAMING

2. Change the above line to the following: 
datastore=//oracle/OCAC:NAMING.

3. Save the file. 

You must also use the System Management Console to change the database value from db2 to oracle. Refer to 
"Configure the System Management Console" in the IBM WebSphere Business Components Studio Version 1.1 
Installation Guide for further details.  

Create the database 
Create the database by using the appropriate Oracle facilities to create the database instance OCAC. 

The following is an example of how to create an Oracle database:  

1. Run the sqlplus tool provided by Oracle. Enter the user name and password when prompted. 

2. Enter the following commands at the prompts:  
CREATE USER "IBMSF" IDENTIFIED EXTERNALLY DEFAULT TABLESPACE "USERS"
TEMPORARY TABLESPACE "TEMP" PROFILE DEFAULT QUOTA UNLIMITED ON "TEMP"
QUOTA UNLIMITED ON "USERS" ACCOUNT UNLOCK;
GRANT "CONNECT" TO "IBMSF";
ALTER USER "IBMSF" DEFAULT ROLE ALL;

Create the tables 
Create the database tables in the OCAC database as follows:  

1. Run the sqlplus tool provided by Oracle. Enter the user name and password when prompted. 

2. Enter the following command at the prompt: 
@com\ibm\sf\db\oracle\OCAC-Create-Oracle-Table.sql
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Create the indices 
Create the database indices as follows:  

1. Run the sqlplus tool provided by Oracle. Enter the user name and password when prompted. 

2. Enter the following command at the prompt: 
@com\ibm\sf\db\oracle\OCAC-Create-Oracle-Index.sql

Prime SanFrancisco 
Prime SanFrancisco for Oracle by using the following command: 
java com.ibm.sf.gf.NamingAdmin -reset -containerprimelist OCAC-Prime-Oracle.list
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Online Sales Desk sample 

Online Sales Desk sample prerequisites, files, and 
preliminary steps 

Prerequisites 
If you are going to deploy this sample in the VisualAge for Java WebSphere Test Environment, these instructions 
assume that you have installed VisualAge for Java in the directory C:\VAJava35 with the following:  

• IBM EJB Development Environment feature 

• IBM WebSphere Test Environment feature 

• AC Services EJBs in the following EJB groups: 

o ACServices 

o LocalizableText 

See the following topics in the IBM WebSphere Business Components, Version 1.1 Installation Guide:  

• "Prepare the VisualAge for Java environment" shows you how to add the above features 

• "Deploy the AC Services in the VisualAge for Java WebSphere Test Environment" shows you how to 
create the AC Services EJB groups. 

Location of sample files 
This sample is installed in <Online Sales Desk sample directory>, which is the following directory: 
<WSBC directory>\<samples subdirectory>\OrderCapture

The directory <WSBC directory> is where you have installed IBM WebSphere Business Components Studio 
Version 1.1, and <samples subdirectory> is the subdirectory where the samples are located, which is 
ACFeatures\Samples.  

The following lists the locations of the .jar files of the Advanced Components (ACs) or services that this sample 
requires:  

Required .jar files for the sample 
Advanced Component 
or service 

Directory 

Customer Profile AC <WSBC directory>\ACFeatures\ 
Components\CustomerProfile 

Order Capture AC <WSBC directory>\ACFeatures\ 
Components\OrderCapture 

ProductCatalog AC <WSBC directory>\ACFeatures\ 
Components\ProductCatalog 

AC Services <WSBC directory>\ 
Services\BaseServices 
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The following lists the files required for this sample:  

• non-Java Web files found in <Online Sales Desk sample directory> 

o \web\*.html 

o web\images\*.gif 

o web\images\*.jpg 

o web\*.jsp 

o web\scripts\*.js 

• INI file for Order Capture data setup found in <Online Sales Desk sample directory>\setup\  

o OCSampleCompany.ini 

• XML files found in <Online Sales Desk sample directory> 

o xml\*.xml 

o xml\*.dtd 

• batch files that populate the sample's databases found in <Online Sales Desk sample directory>\setup\ 

o OCSample.bat 

o customerProfileEnterpriseDB.bat 

o customerProfileEnterpriseData.bat 

o customerProfileEnterpriseTables.bat 

o customerProfileCodeTables.bat 

o customerProfileContactPointsTables.bat 

o productCatalogInsertData.bat 

o productCatalogCreateTables.bat 

• batch files that configure the WebSphere Application Server structure for the sample found in <Online 
Sales Desk sample directory> 

o WSConsoleTree.bat 

• class and resource files not in JARs 

o <WSBC directory>\com\ibm\...\*.* 

• Initialization files found in <WSBC directory> 

o SFconfig.ini 

o WSBCconfig.ini 

• .jar files from the sample found in <Online Sales Desk sample directory> 

o OCS.jar 
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• .jar files from the Customer Profile AC 

o CommonCoreAC.jar 

o CommonCustomerSuite.jar 

o CommonParameterSuite.jar 

o CustomerProfileAC.jar 

o CustomerProfileACEJB.jar 

• .jar files from the Product Catalog AC  

o CommonCoreAC.jar 

o CommonParameterSuite.jar 

o ProductCatalogAC.jar 

o ProductCatalogACEJB.jar 

• .jar files from the Order Capture AC  

o ACOrderCaptureCommon.jar 

o ACOrderCaptureServer.jar 

o ACOrderCaptureServerSF.jar 

o ACOrderCaptureEJB.jar 

• .jar files from AC Services. See the section "Advanced Component Services" in the IBM WebSphere 
Business Components Studio Version 1.1 Installation Guide for a list of these files. 

Edit the SFconfig.ini file 
Open the SFconfig.ini file in a text editor. Make sure the following properties are set correctly. If they are not, 
correct or add them:  

• InstallBase = <WSBC directory> 

• datastore = //db2/OCAC:ibmsf.Naming  

Note: This value assumes that you are using DB2 

• GSM_host = <your system name> 

• sfenv = <WSBC directory>\\com\\ibm\\sf\\etc\\sfenv.ini 

• SFSchemaMapPreferences = <WSBC directory>\\preferences\schemamap 

• naminguser= 

• namingpass= 
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If you want to test this sample in the VisualAge for Java WebSphere Test Environment, make sure the following 
properties are set:  

• theJVM = <fully qualified path to your java.exe (for example,
d:\\java1.2\\bin\\java)> -Xbootclasspath/p:<WSBC directory>\\hack  

Note: Create the directory <WSBC directory>\hack if it does not exist. This is only needed for 
running inside VisualAge for Java. 

Save your changes to the file. 

Check the system paths 
Ensure that there are no spaces in your PATH or CLASSPATH environment variables. If there are spaces, specify 
the directory as XXXXXX~1 where XXXXXX is the first 6 characters (not spaces) of the directory name. If the 
directory is over 6 characters, add "~1" to the end. 

1. Make sure that the following path is in your NT System PATH environment variable (it may be in your NT 
User PATH, but you need to add it to the System PATH as well): 
<WSBC directory>\com\ibm\sf\bin

2. Make sure that the following paths are in your system CLASSPATH environment variable:  

o <WSBC directory> 

o <WSBC directory>\ACFeatures\Components\
OrderCapture\ACOrderCaptureServerSF.jar 

o <WSBC directory>\ACFeatures\Components\
OrderCapture\ACOrderCaptureCommon.jar 

o <WSBC directory>\Services\BaseServices\ACServicesServer.jar 

Create output directory 
Check whether the directory <WSBC directory>\Logs exists. If this directory does not exist, create it. This 
directory will contain output from running the sample on WebSphere Application Server. 

Edit and copy the OCSampleCompany.ini file 
1. Open the OCSampleCompany.ini file in a text editor. Check that the paths to the XML files listed in 

this .ini file are correct. For example, suppose the following string appeared in the .ini file:  
C:\\xml\\OC_sync_currency_setup.xml

If you have installed WSBC in C:\WSBC\, you would change the above string to the following (without 
any intervening white space):  
C:\\WSBC\\ACFeatures\\Samples\\OrderCapture

\\xml\\OC_sync_currency_setup.xml

Save your changes to this file. 

2. Copy the OCSampleCompany.ini to the <WSBC
directory>\com\ibm\wsbc\ac\OrderCapture directory. Create this directory if it does not 
exist. 
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Edit the OrderCaptureSMSpec.xml file 
1. Open the OrderCaptureSMSpec.xml file in a text editor or an XML editor. 

2. In this file, find the modelMBeanAttributeDescriptor tag with the name attribute equal to "DTDPATH". 
Change the value attribute in this tag so that it points to the directory of the DTD files in Order Capture. 
This directory is <WSBC directory>\ACFeatures\Components\OrderCapture\dtd. For 
example, you would change the value attribute from "C:\xml" to "C:\Program
Files\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\dtd". 

3. Save your changes to this file. 

Create and populate the databases 
Create and populate the CPENT and PROCAT databases by executing the following batch file from the <Online 
Sales Desk sample directory>\setup directory:  
db2cmd OCSample.bat

Note: You may see some output from this command that look like errors. For example, you might see some of the 
following: 
DB21034E The command was processed as an SQL statement because it was not a
valid Command Line Processor command. During SQL processing it returned:
SQL0204N "USERID.CODE_CATEGORY" is an undefined name. SQLSTATE=42704
SQL1013N The database alias name or database name "FOO " could not be
found. SQLSTATE=42705

Messages like the above are expected and do not mean that the command has failed. 

Test and deploy the Online Sales Desk sample in the 
VisualAge for Java WebSphere Test Environment 

Prerequisites 
Ensure that you have followed the instructions in the section "Online Sales Desk sample prerequisites, files, and 
preliminary steps." This section also lists the location of the files for this sample. 

These instructions assume that you have imported the following into the VisualAge for Java Workspace:  

• AC Services EJBs in the following EJB groups: 

o ACServices 

o LocalizableText 

Note: For a given AC, ensure that you import the .jar files that contain EJBs last. 

In the IBM WebSphere Business Components, Version 1.1 Installation Guide see the following topics for 
information about importing files into VisualAge for Java:  

• "Install, deploy, and run an AC in VisualAge for Java" shows you how to import the .jar files of an AC, as 
well as the .jar files for the EJBs for an AC. 

• "Deploy the AC Services in the VisualAge for Java WebSphere Test Environment" shows you how to 
import the .jar files of the AC services, as well as the .jar files for the EJBs of the AC Services. 
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Copy the non-Java code files 
Assume that you have installed VisualAge for Java in the directory C:\VAJava35. Copy the non-Java code files (and 
their directory structure) in the directory C:\VaJava35\ide\project_resources\IBM WebSphere
Test Environment\hosts\default_host\default_app.  

Import .jar files into VisualAge for Java 
Import each group of .jar files into the same project. For example, you would import the group of Order Capture AC 
.jar files (ACOrderCaptureCommon.jar, ACOrderCaptureServer.jar, 
ACOrderCaptureServerSF.jar, and ACOrderCaptureEJB.jar) into one project. You could name this 
project OrderCapture.  

Note: The *EJB.jar files in each group of .jar files should be imported after all other .jar files in the group have been 
imported. 

For example, the following steps describe how to import the .jar file named ACOrderCaptureServer.jar into 
a project named OrderCapture:  

1. In the Workbench, on the menu bar, click File > Import.  

2. In the Import SmartGuide, select the Jar file radio button as your import source. Click Next.  

3. For the Filename field, enter the full path name for the ACOrderCaptureServer.jar file. For the 
Project field, enter OrderCapture (or any other unique identifier).  

4. Ensure that the .class checkbox is selected. Click the Details button next to the .class check box. In the 
Class file import window, click Select all. Click OK.  

5. Repeat step 4 for the other two Details buttons. 

6. Click Finish.  

7. Repeat steps 1-6 for each of the .jar files in the same group. 

Repeat steps 1-7 for each group of .jar files for the Product Catalog and Customer Profile ACs. 

Note: You may notice that Product Catalog and Customer Profile share some .jar files in their groups of required .jar 
files. These common .jar files do not need to be imported twice. It makes no difference which project they are 
imported into as long as they are imported. 

Import additional class files into VisualAge for Java 
The following steps describe how to import the additional class files needed for this sample:  

1. In the Workbench, on the menu bar, click File > Import.  

2. In the Import SmartGuide, select the Directory radio button as your import source. Click Next.  

3. In the Directory field, enter the partial path to the class files. This path is <WSBC directory>\com. In 
the Project field, enter Class Files, or any other unique identifier. 

4. Ensure that the .class checkbox is selected. Click the Details button next to the .class check box. In the 
Class file import window, ensure that the com and ibm directories are selected. Click OK.  

5. Ensure that only the .class check box is selected. Click Finish. 

Repeat steps 1-5 with the following exceptions:  

• For the Directory field, enter <WSBC Directory> 

• Click the Details button next to the .resource check box. In the right frame of the Resource file import 
window, ensure that only the com directory is selected. 
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Import additional .ini files into VisualAge for Java 
The following steps describe how to import the additional .ini files needed for this sample:  

1. In the Workbench, on the menu bar, click File > Import.  

2. In the Import SmartGuide, select the Directory radio button as your import source. Click Next.  

3. In the Directory field, enter the partial path <WSBC directory>. In the Project field, click Browse and 
select the project Class Files (or the name of the project where you imported the class files). 

4. Ensure that the .resource checkbox is selected. Click the Details button next to the .resource check box. In 
the Resource file import window, ensure that only the SFconfig.ini and WSBCconfig.ini files 
are selected. Click OK.  

5. Click Finish. 

Export class files into the WSBC directory structure 
The following steps describe how to export the class files needed for this sample:  

1. In the Workbench, click the Packages tab. Scroll down to find the package 
com.ibm.websphere.exception.  

2. Right-click the package and select Export from the pop-up menu.  

3. In the Export SmartGuide, select the Directory radio button as your import source. Click Next.  

4. In the Directory field, enter the directory <WSBC directory>.  

5. Ensure that the .class checkbox is selected. Click the Details button next to the .class check box. In the 
Class file export window make sure all the classes from the selected package are selected. Click OK.  

6. Click Finish.  

Repeat steps 1-6 for the following packages:  

• com.ibm.websphere.command 

• org.w3c.dom  

Export the class sun.rmi.server.UnicastRef to the <WSBC directory>\hack directory:  

1. Right-click the UnicastRef class and select Export from the pop-up menu,  

2. In the Export SmartGuide, select the Directory radio button as your export source. Click Next.  

3. In the Directory field, enter the directory <WSBC directory>\hack.  

4. Ensure that the .class checkbox is selected. Click the Details button next to the .class check box. In the 
Class file export window, make sure that only the UnicastRef class is selected. Click OK.  

5. Click Finish.  
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Start the WebSphere Test Environment Server 
1. Stop the IBM HTTP Server and the IBM WS AdminServer services. 

2. In the Workbench, on the menu bar click Windows > Options.  

3. Select the Resources object. In the text box Workspace class path, enter the full path names of the file 
db2java.zip (for example, C:\SQLLIB\java\db2java.zip), and the <WSBC directory>\hack. 
Click Apply. Click OK.  

4. In the Workbench, on the menu bar click Workspace > Tools > WebSphere Test Environment.  

5. In the WebSphere Test Environment Control Center window, select the Servlet Engine object. Click 
Edit Class Path.  

6. In the Servlet Engine Class Path window, click Select All. Click OK.  

7. In the WebSphere Test Environment Control Center window, click Start Servlet Engine.  

8. Select the Persistent Name Server object. Ensure that jdbc:db2:was is specified in the Database 
URL field, and com.ibm.db2.jdbc.app.DB2Driver is specified in the Database driver field (if 
using DB2). You can leave the Database ID and password fields blank.Click Start Name Server.  

9. Select the DataSource Configuration object. 

Note: The Persistent Name Server must be started before you can click on this object. 

10. From the DataSource Configuration panel, click Add. Fill in the following fields:  

o DataSource name: cpEnt 

o Database URL: jdbc:db2:cpEnt 

Click OK. 

11. Repeat step 10 with the following values:  

o DataSource name: proCat 

o Database URL: jdbc:db2:proCat 

Create and deploy EJB groups 
Create and deploy the following EJB groups:  

• ACServices, LocalizableText, (see the IBM WebSphere Business Components, Version 1.1 Installation 
Guide for instructions on how to create these groups) 

• CustomerProfileAC 

• ProductCatalogAC 

• OrderCaptureAC 

The following steps describe how to create the OrderCaptureAC EJB group:  

1. In the Workbench, select the EJB tab.  

2. On the menu bar, click EJB > Add > EJB Group 
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3. In the Project field, specify the OrderCapture project (or whatever project name you gave when you 
imported the Order Capture AC .jar files).  

4. In the Create a new EJB Group named field, enter OrderCaptureAC. 

5. Click Finish.  

Repeat steps 1-5 for the Customer Profile and Product Catalog ACs. 

The following steps describe how to create the EJBs for the Order Capture AC EJB group:  

1. In the Workbench, select the EJB tab.  

2. In the Enterprise Bean pane, you should see the EJB groups that you have created. Right-click the 
OrderCaptureAC EJB group and select Import Enterprise Beans... from the pop-up menu. 

3. Under the type of files to import, make sure the bean and class boxes are checked. 

4. Click the Browse button next to the Filename field, and find and select the ACOrderCaptureEJB.jar 
file. 

5. Click the Details... button next to the Beans, click the Select All button, and click OK. 

6. Repeat step 5 for the class details. 

7. Click Finish.  

Repeat steps 1-7 for each EJB group, selecting the appropriate *EJB.jar file for each group. 

Generate the deployed code for the EJBs  
The following steps describe how to create the deployed code for the EJBs:  

1. In the Workbench, select the EJB tab.  

2. In the Enterprise Bean pane, select the OrderCaptureAC EJB group. Right-click on the group and select 
Generate Deployed Code.  

3. Repeat steps 1-2 for the Customer Profile and  Product Catalog ACs. 

Create and start Enterprise JavaBeans servers 
Deploy the EJBs that are in the following EJB groups:  

• ACServices 

• LocalizableText 

• CustomerProfileAC 

• ProductCatalogAC 

• OrderCaptureGroup 

The following steps describe how to deploy the EJBs:  

1. In the Workbench, select the EJB tab.  

2. In the Enterprise Bean pane, select all of the above-mentioned EJB groups. Right-click this multiple 
selection and choose Add To > Server Configuration from the pop-up menu.  
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3. In the EJB Server Configuration window, right-click the EJB Server that you have just created and select 
Properties from the pop-up menu.  

4. In the Properties for EJB Server window, change both the Transaction Timeout and the Transaction 
Inactivity Timeout fields to a very large number such as 6000000. Click OK.  

5. In the EJB Server Configuration window, right-click the EJB Server that you have just created and select 
Start Server from the pop-up menu.  

6. Wait until the server is started. The message "Server open for business" should appear in the Console.  

Register JNDI settings 
1. In the Workbench, find and expand the com.ibm.wsbc.samples.oc package. Right-click the 

OCSACComponentSetup class and select Properties from the pop-up menu.  

2. In the Properties for OCSACComponentSetup window, click the Class Path tab. Click the Edit button 
next to the Project path field. Click Select All. Click OK. Click OK again to save your settings.  

3. Run the main method of the OCSACComponentSetup class. This will deploy and start up the EJBs.  

As an alternative, the steps of deploying and starting the EJBs can be run separately, by doing steps 1-3 for the 
following classes:  

• DeployCustomerProfile 

• DeployProductCatalog 

• DeployOrderCapture 

• OCSStartup, OCSStart, OCSCreateData.  

Execute the sample 
Open the following in a Web browser:  
http://localhost:8080/Login.jsp

You should see a login screen. The following table lists the valid user ID and password combinations for this 
sample: 

User IDs and passwords for the Order Capture sample 
User ID Password 

987654 mynameistommy 

123456 mynameisbetsy 

456789 napalisthebest 

You can also find these values, as well as other data, by looking at the following:  

• setup XML files (found in ..\xml\*.xml) 

• CPENT and PROCAT databases in DB2 (if you are using DB2 for datastore) 

Note: If you have previously installed and uninstalled WSBC, you may get the following error: 
Error 500 - wrong name error.
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To fix this, delete the contents of the C:\VAJava35\ide\project_resources\IBM WebSphere Test
Environment\temp\JSP1_0\default_app directory. This directory contains compiled JSPs that may refer 
to a previous installation of WSBC. After deleting the contents of this directory, you should be able to execute the 
sample. 

Stop and restart the sample 
Follow these steps to stop the sample:  

1. Run the following class: 
com.ibm.wsbc.samples.oc.OCSStop

2. Stop the EJB Servers for this sample, the Persistent Name Server, and the Servlet Engine. 

Follow these steps to restart the sample:  

1. Start the Persistent Name Server, the Servlet Engine, and the EJB Servers for this sample. 

2. Run the following classes: 
com.ibm.wsbc.samples.oc.OCSStartup
com.ibm.wsbc.samples.oc.OCSStart

3. Open the URL listed above in a Web browser. 

Destroy and recreate sample data 
If an error occurred in the OCSCreateData, or you wish to destroy the sample data that you have created, you can 
run the class com.ibm.wsbc.samples.oc.OCSDestroyData.  
Note: You must have all servers up, and you must have deployed and started the EJBs (through 
OCSACComponentSetup or OCSStartup and OCSStart). 
After running the OCSDestroyData, you must run the OCSCreateData again before running the sample to 
reinitialize the sample data (the servers must be up and the EJBs must be deployed and started through 
OCSACComponentSetup or OCSStartup and OCSStart). 

Test and deploy the Online Sales Desk sample on 
WebSphere Application Server 

Prerequisites 
If you have previously created the hack directory, this directory should be removed or renamed when running on 
WebSphere Application Server. In addition, in the SFConfig.ini file, ensure that the theJVM variable is set to java 
(theJVM=java). 
Ensure that you have followed the instructions in the section "Online Sales Desk sample prerequisites, files, and 
preliminary steps." This section also lists the location of the files for this sample. 

The following instructions assume that you have installed WebSphere Application Server in 
C:\WebSphere\AppServer 

Modify the admin.config file 
1. Close the WebSphere Administrator's Console. Shut down the IBM WS AdminServer Service. 

2. Open the C:\WebSphere\AppServer\bin\admin.config file in a text editor such as Notepad. 
Find the line in this file that starts with the following string:  
com.ibm.ejs.sm.adminserver.classpath
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Assuming that <WSBC directory> is C:\WSBC, append to this line the following string (without the 
line breaks):  
;C\:/WSBC;
C\:/WSBC\ACFeatures\Components\OrderCapture\ACOrderCaptureServerSF.jar;
C\:/WSBC\ACFeatures\Components\OrderCapture\ACOrderCaptureCommon.jar;
C\:/WSBC\ACFeatures\Samples\OrderCapture\OCS.jar;
C\:/WSBC\Services\BaseServices\ACServicesEJBClient.jar;
C\:/WSBC\Services\BaseServices\ACServicesClient.jar;
C\:/WSBC\Services\BaseServices\ACServicesServer.jar;
C\:/WSBC\Services\BaseServices\jmxri.jar

Note: In the admin.config file, you must precede the colon (:) character with the backslash (\) 
character. 

3. Save the admin.config file. 

Start the WSBC Server 
1. Start the IBM WS AdminServer Service. Open the Administrator's Console. 

2. Expand the root node. 

3. Expand the node named after your server. 

4. Right-click the WSBC Server node and select Start from the pop-up menu. 

Edit the WSConsoleTree.bat file  
1. Open the WSConsoleTree.bat file in a text editor. 

2. Find the following section in the file and set the variables appropriate to your system:  
set WSBC_ROOT=C:\Progra~1\IBM\WSBC\1.1\
set HOSTNAME=hostname
set SNAME=WSBC Server
set DB2JAVA_ZIP=D:\SQLLIB\java\db2java.zip

The value of WSBC_ROOT is the directory where you have installed IBM WebSphere Business 
Components Studio Version 1.1. 

Note: In this batch file, you cannot have any spaces in your directory path, and you must add a backslash 
(\) at the end of directory names. For example, you would change C:\Program Files\ to 
C:\Progra~1\. 

The value of HOSTNAME is your host name. Use the short name of your server. For example, if the name of 
your server is cacciato.torolab.ibm.com, you would use cacciato as your host name. 

The value of SNAME is the name of your server. 

The value of DB2JAVA_ZIP is the full path name of the db2java.zip file, which contains the JDBC 
drivers for the DB2 database. 

3. Save your changes to this file. 
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Run the WSConsoleTree.bat file  
1. Go to the C:\WebSphere\AppServer\bin directory and run the following at a command prompt:  

<WSBC directory>\ACFeatures\Samples\OrderCapture\WSConsoleTree.bat

This command does the following:  

• Fills in the dependent classpath for the node with the following values: 
<WSBC directory>\ACFeatures\Components\CustomerProfile\CommonCustomerSuite.jar
<WSBC directory>\ACFeatures\Components\CustomerProfile\CustomerProfileAC.jar
<WSBC directory>\ACFeatures\Components\OrderCapture\ACOrderCaptureCommon.jar
<WSBC directory>\ACFeatures\Components\OrderCapture\ACOrderCaptureEJB.jar
<WSBC directory>\ACFeatures\Components\OrderCapture\ACOrderCaptureEJBClient.jar
<WSBC directory>\ACFeatures\Components\OrderCapture\ACOrderCaptureServerSF.jar
<WSBC directory>\ACFeatures\Components\ProductCatalog\CommonCoreAC.jar
<WSBC directory>\ACFeatures\Components\ProductCatalog\CommonParameterSuite.jar
<WSBC directory>\ACFeatures\Components\ProductCatalog\ProductCatalogAC.jar
<WSBC directory>\Services\BaseServices\ACEI18NEJBClient.jar
<WSBC directory>\Services\BaseServices\ACServicesClient.jar
<WSBC directory>\Services\BaseServices\ACServicesSMClient.jar
<WSBC directory>\Services\BaseServices\ACServicesServer.jar
<WSBC directory>\Services\BaseServices\jmxri.jar

• Sets the command argument value for the WSBC server to the following value: 
<WSBC directory>\
<WSBC directory>\ACFeatures\Components\CustomerProfile\CommonCustomerSuite.jar
<WSBC directory>\ACFeatures\Components\CustomerProfile\CustomerProfileAC.jar
<WSBC directory>\ACFeatures\Components\OrderCapture\ACOrderCaptureCommon.jar
<WSBC directory>\ACFeatures\Components\OrderCapture\ACOrderCaptureEJB.jar
<WSBC directory>\ACFeatures\Components\OrderCapture\ACOrderCaptureEJBClient.jar
<WSBC directory>\ACFeatures\Components\OrderCapture\ACOrderCaptureServer.jar
<WSBC directory>\ACFeatures\Components\OrderCapture\ACOrderCaptureServerSF.jar
<WSBC directory>\ACFeatures\Components\ProductCatalog\CommonCoreAC.jar
<WSBC directory>\ACFeatures\Components\ProductCatalog\CommonParameterSuite.jar
<WSBC directory>\ACFeatures\Components\ProductCatalog\ProductCatalogAC.jar
<WSBC directory>\ACFeatures\Samples\OrderCapture\OCS.jar
<WSBC directory>\Services\BaseServices\ACEI18NEJBClient.jar
<WSBC directory>\Services\BaseServices\ACServicesEJBClient.jar
<WSBC directory>\Services\BaseServices\ACServicesSMClient.jar
<WSBC directory>\Services\BaseServices\ACServicesServer.jar
<WSBC directory>\Services\BaseServices\jmxri.jar

• Creates the Order Capture Sample Web application 

• Creates the datasources and the database driver 

Edit initialization files, and configure and populate the databases 
1. Ensure that you have edited the SFconfig.ini, OCSampleCompany.ini, and 

OrderCaptureSMSpec.xml files as described in "Online Sales Desk sample prerequisites, files, and 
preliminary steps." 

2. Ensure that you have created and configured the CPENT and PROCAT databases as described in "Online 
Sales Desk sample prerequisites, files, and preliminary steps." 
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Register JNDI settings 
1. Open a new command window. Note that if any of your environment variables were modified, you must 

open a new window to pick up the changes. Run the following command (without the line breaks) with the 
locations modified to match your installation: 
set classpath=%CLASSPATH%;
D:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Samples\OrderCapture\OCS.jar;
D:\WebSphere\AppServer\lib\ujc.jar;
D:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesEJBClient.jar;
D:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesClient.jar;
D:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\ACServicesServer.jar;
D:\PROGRA~1\IBM\WSBC\1.1\Services\BaseServices\jmxri.jar;
D:\PROGRA~1\IBM\WSBC\1.1\ACFeatures\Components\OrderCapture\
ACOrderCaptureServerSF.jar

2. Make sure that the following .jar files are now in your CLASSPATH environment variable: 

o ACOrderCaptureServerSF.jar  

o OCS.jar 

o <WebSphere AppServer directory>\AppServer\lib\ujc.jar 

o ACServicesEJBClient.jar 

o ACServicesClient.jar 

o ACServicesServer.jar 

o jmxri.jar 

The directory <WebSphere AppServer directory> is where you have installed WebSphere Application 
Server.  

3. From a command prompt, execute the following:  
java com.ibm.wsbc.samples.oc.OCSACComponentSetup

As an alternative, you may separately deploy and start each of the EJBs by executing the following classes. You 
might want to run these commands separately in order to localize any errors:  

• com.ibm.wsbc.samples.oc.DeployCustomerProfile 

• com.ibm.wsbc.samples.oc.DeployProductCatalog 

• com.ibm.wsbc.samples.oc.DeployOrderCapture 

• com.ibm.wsbc.samples.oc.OCSStartup, com.ibm.wsbc.samples.oc.OCSStart, 
com.ibm.wsbc.samples.oc.OCSCreateData. 

Note: If after running the above command(s) you see the command hang indefinitely displaying the following 
output: 
Before start(), AdvancedComponents:ACInstanceName=OrderCaptureI001 is in state STOPPED

view the <WSBC directory>\sflogs\SFGSMProcess.log file. If the file reports an Unsatisfied Link 
exception finding ibm*.dll, reboot the machine, restart the WSBC server, and run the above commands again. 

Execute the sample 
Open the following in a Web browser:  
http://localhost/OrderCaptureSample/Login.jsp
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You should see a login screen. The following table lists the valid user ID and password combinations for this 
sample: 

User IDs and passwords for the Order Capture sample 
User ID Password 

987654 mynameistommy 

123456 mynameisbetsy 

456789 napalisthebest 

You can also find these values, as well as other data, by looking at the following:  

• setup XML files (found in ..\xml\*.xml) 

• CPENT and PROCAT databases in DB2 (if you are using DB2 for datastore) 

Note: If you have previously installed and uninstalled WSBC, you may get the following error: 
Error 500 - wrong name error.

To fix this, delete the contents of the C:\WebSphere\AppServer\temp\default_host\WSBC Order
Capture Sample directory. This directory contains compiled JSPs that may refer to a previous installation of 
WSBC. After deleting the contents of this directory, you should be able to execute the sample. 

Stop and restart the sample 
Follow these steps to stop the sample:  

1. Run the following command to stop the sample: 
java com.ibm.wsbc.samples.oc.OCSStop

2. Stop the WSBC Server in WebSphere Application Server. 

Follow these steps to restart the sample:  

1. Start the WSBC Server in WebSphere Application Server. 

2. Run the following command to restart the sample: 
java com.ibm.wsbc.samples.oc.OCSStartup

3. Run the following command to restart the SanFrancisco servers: 
java com.ibm.wsbc.samples.oc.OCSStart

4. Open the URL listed above in a Web browser. 

Destroy and recreate sample data 
If an error occurred in the OCSCreateData, or you wish to destroy the sample data that you have created, you can 
run the class com.ibm.wsbc.samples.oc.OCSDestroyData.  
Note: You must have all servers up, and you must have deployed and started the EJBs (through 
OCSACComponentSetup or OCSStartup and OCSStart). 
After running the OCSDestroyData, you must run the OCSCreateData again before running the sample to 
reinitialize the sample data (the servers must be up and the EJBs must be deployed and started through 
OCSACComponentSetup or OCSStartup and OCSStart). 
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Troubleshooting 
Any exception can show up in the following six places:  

• WSBCStderr.log 

• WSBCStdout.log 

• C:\actest\ac.log

• C:\actest\ac.trc 

• C:\PROGRA~1\IBM\WSBC\1.1\sflogs\SFGSMProcess.log 

• C:\PROGRA~1\IBM\WSBC\1.1\sflogs\OCACServer.log 

Note: To see the ac.log and ac.trc files, you must create the c:\actest directory. 
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Notices 
IBM may not offer the products, services, or features discussed in this document in all countries. Consult your local 
IBM representative for information on the products and services currently available in your area. Any reference to 
an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or 
service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM 
intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter described in this document. The 
furnishing of this document does not give you any license to these patents. You can send license inquiries, in 
writing, to: 
IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  
The following paragraph does not apply to the United Kingdom or any other country where such provisions 
are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties 
in certain transactions, therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. Changes are periodically made to the 
information herein; these changes will be incorporated in new editions of the publication. IBM may make 
improvements and/or changes in the product(s) and/or program(s) described in this publication at any time without 
notice. 
Any references in this information to non-IBM Web sites are provided for convenience only and do not in any 
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for 
this IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring 
any obligation to you. 
Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of 
information between independently created programs and other programs (including this one) and (ii) the mutual use 
of the information which has been exchanged, should contact: 
IBM Canada Ltd., 
Department 071, 
1150 Eglinton Avenue East 
Toronto, Ontario, M3C 1H7 
Canada 
Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of 
a fee. 
The licensed program described in this document and all licensed material available for it are provided by IBM 
under terms of the IBM Customer Agreement, IBM International Program License Agreement, or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained 
in other operating environments may vary significantly. Some measurements may have been made on development-
level systems and there is no guarantee that these measurements will be the same on generally available systems. 
Furthermore, some measurement may have been estimated through extrapolation. Actual results may vary. Users of 
this document should verify the applicable data for their specific environment. 
All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and 
represent goals and objectives only. 
 
COPYRIGHT LICENSE:  
This information contains sample application programs in source language, which illustrates programming 
techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any 



 

 Copyright IBM Corp. 2000 25 

form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs 
conforming to the application programming interface for the operating platform for which the sample programs are 
written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or 
imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample 
programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing 
application programs conforming to IBM's application programming interfaces. 

Trademarks and service marks 
The following terms are trademarks of International Business Machines Corporation in the United States, or other 
countries, or both: 
AIX 
CICS 
DB2 
DB2 Universal Database 
e-business 
IBM 
LANDP 
MQSeries 
OS/2 Warp 
OS/390 
RS/6000 
SanFrancisco 
VisualAge 
Visual Banker 
WebSphere 
 
Lotus, Domino, Lotus Notes, and Notes Mail are trademarks of the Lotus Development Corporation in the United 
States, other countries, or both. 
Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in 
the United States, other countries, or both. 
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United 
States, other countries, or both. 
MMX, Pentium, and ProShare are trademarks or registered trademarks of Intel Corporation in the United States, 
other countries, or both. 
UNIX is a registered trademark in the United States, other countries, or both and is licensed exclusively through 
X/Open Company Limited.  
Rational Rose is a registered trademark of Rational Software Corporation. 
Other company, product, and service names may be trademarks or service marks of others. 
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